Computing Practical 1
Introduction to R

22 April 2002

Practical Outline The purpose of this morning’s practical is to provide an introduction
to using R and to illustrate its general data handling and plotting capabilities.

1 Running R for Windows

To start R for windows, click on the Start button and then under Programs>R, choose
R1.4.1.

Eie Edit Misc Packages Windows Help

R Console

R : Copyright 2002, The R Development Core Team
Version 1.4.1 [2002-01-30)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type "license(]' or "licence(]' for distribution details.

R is a collsborative project with many contributors.
Type "contributors()' for more information.

Type "demo(]' for some demos, "help(]' for on-line help, or
‘help.start|]' for a HTHL browser interface to help.
Type "ql)' to quit R.

[Previously saved workspace restored]

~|* By Docusents/winutils/tenp.Pdets®

If the RGui window does not occupy the full screen, then click on the maximize button on
the top right corner of the window.
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1.1 Loading a workspace image file

For this practical, a workspace image has been specially prepared and is available on the
temporary partition, D:\. The file is called .Rdata.
To load the workspace image:

1. Choose Load Workspace from the File drop-down menu.

| File Edit Misc Package
Cowce B code. .
Display file...

Cave 'Workspace...

Load Histony...
Sawe Higtary, .

OK.
: x|
| 3 e = e®cE-
Histon)
[Z.I e:}-:_l!c- P
iy Documents
== Fi -
by Nebwark P Fid | _j E;_J
Files of pe:  [R images (“RDatal =l Cancel /I
%

1.2 Using Help

Various help facilities are available in R for windows.

e If you know the name of the function, but need more information, you can type help
in the R console. For example, to get help on the 1s() function, you can type

> help(1ls)
>
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This will open a window containing information about the functions. Unfortunately
you need to know the name of the function to be able to use this facility.

e A large amount of documentation is also available via the Help drop-down menu.

e
| Help

E Corsale

* FAQonf

| FaQ on R forwindows

B language [standad)...

llidhuudgtEfrPt

About

e The R Language (html) entry opens the main page in the html version of the help

system.
7 The R Language - Miciosoft Internet Explorer o
| Ele Edt View Faortes Took Help =
| = Back » & - Qé,]__@ ‘DhSearch ijfavorites (PHistoy | Zhyv ,3__;5_8 )
| Address [ C\Progsar Files'R\vw] 041 \coc sl b =] PG
=
Statistical Data Analysis @
Manuals
Anlotroductionto B Writing R Edensions
The R language definition R Lats Import/Export
Reference
Search Engme & Keywords

Backages
Miscellaneous Material

Authors Basousces

AboutR

License Frequently Asked Questions Thanks
EAQ for Windows port

TS My Computer _

@] file:///T Frogram Files/R. /] 041 /doc/manusl /R 4ang hirel

This page contains links to many useful resources including a search facility, an
introduction to R, the manuals and, if you are connected to the internet, the FAQ

sites.
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2 Some basic operations in R

2.1 Examining Data Objects

The first step in examining the available data objects is to obtain a listing of all objects
currently accessible. This is done using the 1s() function.

> 1s()
[1] "expl.data" "expl.norm.lratio" "mice.data"
[4] "mice.lratio" "mice.norm.lratio" "mice.not.norm.lratio"
[7] "mice.setup" "small.data" "small.G"

[10] "small.R"

>

Typing the name of an object causes it to be displayed as output in the R console. For
example,

> small.R
[,11 [,2] [,3]
[1,] 983 2190 2517
[2,1] 921 2092 2516
[3,] 5289 12785 7592
[4,] 5569 11044 7874
[5,]1 5320 9404 8113
[6,] 5533 12689 8507
[7,] 5563 12655 8643
[8,] 5670 12989 8521
[9,]1 4746 7998 7125
[10,] 4946 9012 7453
>

allows us to see immediately that small.R is a matrix with 10 rows and 3 columns.
However, for large objects typically associated with microarray data, this is not feasible.
Try typing expl.data.

We can determine the type of an object by using commands is.vector etc.

> is.vector(small.R)

[1] FALSE

> is.matrix(small.R)

[1] TRUE

> is.list(small.R)

[1] FALSE

> is.data.frame(small.R)
[1] FALSE

The dimensions of a matrix can be displayed using the dim function.

> dim(small.R)
[1] 10 3

The object small.data is a list containing four components each of which is a matrix.
It can be displayed in the usual way.

[4]
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> small.data

$R

[1,]
[2,]
[3,]
[4,]
[5,]
[6,]
[7,]
[8,]
[9,]
[10,]

$G

[1,]
[2,]
[3,]
[4,]
[5,]
[6,]
[7,]
[s8,]
[9,]
[10,]

$Rb

[1,]
[2,]
[3,]
[4,]
[5,]
[6,]
[7,]
[8,]
[9,]
[10,]

$Gb

[1,]
[2,]
[3,]
[4,]
[5,]
[6,]
[7,]
[s8,]
[9,]

[,1]
983
921

5289

5569

5320

5533

5563

5670

4746

4946

[,1]
481
453

3185

3350

3242

3412

3447

3557

2879

3282

[,1]
14
14
14
16
16
16
12

8
12
14

[,1]
128
128
128
123
123
118
133
133
133

[,2]
2190
2092
12785
11044
9404
12689
12655
12989
7998
9012

[,2]
1423
1356
10965
10376
9405
11454
11580
11939
7820
8443

[,2]

© © O © N N

14
14
14

[,2]
268
282
282
282
282
275
275
264
271

[,3]
2517
2516
7592
7874
8113
8507
8643
8521
7125
7453

[,3]

1740

1803
11051
11638
12053
12225
12943
12812
11371
11483

,_|
w
—

b

CO 00 W W WU U O Www

[,3]
230
226
234
234
234
234
224
225
225
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[10,] 126 271 225

> length(small.data)

[1] 4

> attributes(small.data)
$names

[1] "R" "G" "Rb" "Gb"

When the commponents of a list are named, as is the case with small.data, the names
can be displayed using the attributes function as shown above. In this case the individual
components can be referred to by name using the "$" symbol. For example:

> small.data$Rb

[,1] [,2] [,3]
[1,] 14 7 3
[2,] 14 7 3
[3,] 14 9 5
[4,] 16 9 5
[5,1 16 9 5
[6,1 16 9 9
[7,] 12 14 9
[8,] 8 14 9
[9,] 12 14 8

[10,] 14 2 8

> is.matrix(small.data$Rb)
[1] TRUE

> dim(small.data$Rb)

[1] 10 3

>

Excerise

Check that expl.data and mice.lratio are both lists. Find the names of their compo-
nents. Check that each component is a matrix and find its dimension.

Note: for this exercise the command line editing feature in the R command window is
very useful.

e Previous commands can be recalled using the 1 key.

e The cursor can be positioned within the command using the < and — keys as
necesary.

e The delete and backspace keys can be used to delete unwanted characters.
e New characters can be typed from the keyboard as usual.

e When the command has been edited, press the enter key to execute it.

For example, if you have previously typed the command dim(small.data$R) you can
enter the command dim(small.data$G) simply by recalling the previous command and
changing the R to a G. Cut and paste functions are also provided in the Edit drop-down
mentu.

[6]
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2.2 Basic Data Manipulation
2.2.1 Arithmetic

Arithmetic expressions typed into R are evaluated and printed out. For example,

> x<-1

> y<-2

> xX+y

[1] 3

> log(x/(1+3xy))
[1] -1.94591

>

Often we want to save the result of a calculation as a new R object and this is done
using the assignment operator <-. For example,

> W<-x+y

> z<-log(x/(1+3%*y))
> w

[1] 3

> z

[1] -1.94591

>

The data objects in an arithmetic expression can be a combination of scalars (single
values), vectors or matrices. If they are all matrices of the same dimension, then the expres-
sion is evaluated. for each component. For example, small.data$R and small.data$Rb
are matrices of red foreground and background intensities. To obtained the background
adjusted intensities we subtract the backgrounds.

> small.data$R
[,11 [,2] [,3]
[1,] 983 2190 2517
[2,1] 921 2092 2516
[3,] 5289 12785 7592
[4,] 5569 11044 7874
[5,] 5320 9404 8113
[6,]1 5533 12689 8507
[7,] 5563 12655 8643
[8,]1 5670 12989 8521
[9,]1 4746 7998 7125
[10,] 4946 9012 7453
> small.data$Rb
[,11 [,2]1 [,3]

[1,1] 14 7 3
[2,1] 14 7 3
[3,] 14 9 5
[4,] 16 9 5
[5,] 16 9 5
[6,1 16 9 9
[7,] 12 14 9
[8,] 8 14 9
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[9,1] 12 14 8
[10,] 14 2 8
> R<-small.data$R-small.data$Rb
>R

[,11 [,2] [,3]

[1,] 969 2183 2514

[2,1] 907 2085 2513

[3,]1 5275 12776 7587

[4,] 5553 11035 7869

[5,] 5304 9395 8108

[6,] 5517 12680 8498

[7,] 5551 12641 8634

[8,] 5662 12975 8512

[9,]1 4734 7984 T117
[10,] 4932 9010 7445
>

With the small example, we can obtain the green background adjusted intensities and
the log intensity ratios, M as follows.

> R<-small.data$R-small.data$Rb
> G<-small.data$G-small.data$Gb
> M<-log(R/G,base=2)

> M
[,1] [,2] [,3]

[1,] 1.4568285 0.91841928 0.7354361
[2,] 1.4806628 0.95705339 0.6722280
[3,]1 0.7870545 0.25811938 -0.5116990
[4,] 0.7830738 0.12858864 -0.5352877
[5,]1 0.7659972 0.04238484 -0.5436900
[6,]1 0.7440434 0.18176361 -0.4967567
[7,] 0.7441741 0.16114960 -0.5588842
[8,]1 0.7256290 0.15231199 -0.5643644
[9,]1 0.7857281 0.08082617 -0.6471849
[10,] 0.6440756 0.14083790 -0.5966068

>

Exercise

Calculate the matrices R, G and M from the full expl.data object by adapting the above
commands. Calculate also the matrix A of average log intensities defined by

A = (logy R + log, G) /2.

2.2.2 Selecting from matrices

Individual elements of a matrix A are addressed using the notation A[i,j] where i is a
number specifying the row and j is a number specifying the columns. Submatrices, row
and columns can also be addressed this way as illustrated below.
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> small.R # The whole matrix
[,11 [,2] [,3]
[1,] 983 2190 2517
[2,]1 921 2092 2516
[3,] 5289 12785 7592
[4,] 5569 11044 7874
[5,] 5320 9404 8113
[6,] 5533 12689 8507
[7,] 5563 12655 8643
[8,] 5670 12989 8521
[9,] 4746 7998 7125
[10,] 4946 9012 7453
> small.R[1,1] # The 1,1 entry.

[1] 983
> small.R[1:3,1:2] # The first 3 rows and 2 columns
[,11 [,2]

[1,] 983 2190
[2,] 921 2092
[3,] 5289 12785
> small.R[2,] # The second row.
[11 921 2092 2516
> small.R[,1] # The first column.
[1] 983 921 5289 5569 5320 5533 5563 5670 4746 4946
>

3 Plotting the data

Data sets arising from microarray experiments are generally too large to dislay as text and
better described using a combination of suitable graphs and summary statistics.

3.1 Histograms

Histograms are produced in R using the hist function. In particular, if x is a vector
containing the data, then hist(x) produces a histogram of the data. Keeping in mind
how columns of matrices are extracted as vectors, we can now look at histrograms of
various quantities on a slide by slide basis. For example, the matrix, R created in the
previous exercise contains the red background adjusted intensities for the three slides from
experiment 1. A histogram for slide 1, together with the mean and standard deviation,

can then be obtained as follows:

> hist(log(R[,1],base=2))

> hist(R[,1])

> mean(R[,1])

[1] 1126.764

> sd(R[,11)

[1] 2697.163

> # The histogram is highly skewed so look at the
> # log-transformed values.

> hist(log(R[,1],base=2))
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> mean(log(R[,1],base=2))
[1] 9.10023

> sd(log(R[,1],base=2))
[1] 1.486119

>

3.2 Saving your graphs

Histograms and other graphs can exported from R in various formats (such as postscript
or JPEG) to be used in other documents. This can be done as follows.

1. Create the desired graphs by typing commands in the R console.

2. When you are happy with graph, click anywhere on the R Graphics window to bring
it to the foreground. The menu bar will now appear as follows.

File  Higtory Reszize ‘Windows

3. Select the Save as item from the File drop-down menu and choose the required
format.

File History Besze Windows

Save az

Cops b the olipboad

Pririt... CTRL+F Prg..

cloze Dewice EBrap. ..
poraT —— Jpag >

(a) Postscript files are suitable when high quality graphics are required but tend to
be large and may require special software to view.

(b) JPEG files will not produce the same quality but tend to be smaller and easier
to handle.

(c) Both formats can be inserted directly into Word and resized as necessary, but
postscript figures are usually not visible on the screen.

(d) Other formats are also available.

[10]
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4. Choose a name and folder for the new file and click on the Save button.

20
Savein |23 Practical 1 | « @B

|1 svpics

] figure 1 ps
:] figurel.2 pz
3 figure1.3 ps
] ligurel 4 ps
J figure1 5. ps
z] figure1 & pz
ﬁ figurel .7 ps

File nare: -_.:.._1.:. Tred|

Led Lo

Save as lype: IPostsclipt files [* ps)

[ s ]

5. A new file containing your graph in the specified format should then have been
created.

Exercise

Save the histogram of the red log intensities for slide 1 as a JPEG file on the Temp partition
"D:\". Check that the file has been created.

3.3 Customizing histograms

R provides extremely powerful facilities for producing customized graphics and a systematic
discussion is beyond the scope of this workshop. To give some idea of what can be acheived,
suppose we wish to compare the distributions of red and green background values for slide 1
of experiment 1. To do this effectively, we would like to produce clearly labelled histograms
one above the other with the same scale on the horizontal axis. Shown below is a sequence
of commands that achieve this.

> # First set up the graphics windows for multiple plots

> par (mfrow=c(2,1)) # multiple figures, by row, 2 rows one column
> # Now find the total range of the values to be plotted

> range(expl.data$Rb[,1])

[1] 1 31
> range(expl.data$Gb[,1])
[1] 67 146

> # We will use the range 0-150 for both graphs

> hist(expl.data$Rb[,1],col="red",main="Red Background",

+ xlab="intensity",xlim=c(0,150) ,breaks=c(0:50)*3)

> hist(expl.data$Gb[,1],col="green" ,main="Green Background",
+ xlab="intensity",xlim=c(0,150) ,breaks=c(0:50)*3)

>

The result is shown in Figure 1. In generating the histograms, the following optional
arguments were used:

[11]
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Figure 1: Red and green background values for slide 1

col: Specify the color of the bars.

main: Specify the title for the histogram.

xlab: Specify the label for the x-axis. (ylab is also available)
xlim: Set the lower and upper limits of the x-axis.

breaks: Specify the boundaries for the class intervals. In the case,

0-3,3—-6,...,147 — 150.

As a second example, shown below is the command to generate a histogram of the log
ratios M from the first slide of experiment 1. In this case the bars are colored on a scale
where M = —6 corresponds to pure green and M = +6 pure red. Detailed explanation of
this command will not be given, but the result is shown in Figure 2.

> hist(expl.norm.lratio[,1],nclass=20,col=rainbow(67)[24:5],
+ main="Slide 1",xlab="Log Intensity Ratio")
>

[12]
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Figure 2: Normalised log ratios from slide 1, experiment 1.

3.4 Scatter Plots

Another commonly used plot is the scatter plot. If x and y are vectors of the same length,
the command plot(x,y) produces a scatter plot of y vs x. That is y on the vertical and
x on the horizontal axis. For example, to determine the extent to which normalisation is
required we can plot the log ratios vs average intensity from experiment 1 using the M and
A matrices that you created previously. The M vs A plot for slide 1 can be obtained using
the following commands and the result is shown in Figure 3.

# Basic version

plot(A[,1],M[,1])

# Can also specify options as for the histogram
plot(A[,1]1,M[,1],main="M vs A, Slide 1", col="blue",
xlab="Average log intensity",ylab="Log ratio")

# and add a line at M=0 to the plot
abline(0,0,col="red")

+ V V Vv VvV

vV V V

[13]
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Mvs A, Slide 1

Log ratio
0

Average log intensity

Figure 3: M vs A plot from slide 1.

4 Sorting and Selecting

Graphs enable use to visually identify interesting aspects of the data. However, it is often
also necessary to be able to examine the data in other ways. For example, we might want
to identify all genes with M above a certain threshold or perhaps the top ten values. The
most important functions for this purpose are sort and order.

sort: If x is a vector then sort(x) produces a vector of the same length as x with the
components sorted in ascending order.

order: If x is a vector then order (x) produces a vector of same length as x containing
the indices of the sorted components.

To illustrate, we consider the green matrix from the small data set.

> > small.G
[,11 [,21 [,3]
[1,]1 481 1423 1740
[2,] 453 1356 1803
[3,] 3185 10965 11051
[4,] 3350 10376 11638
[5,] 3242 9405 12053

[14]
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[6,] 3412 11454 12225

[7,] 3447 11580 12943

[8,] 3557 11939 12812

[9,] 2879 7820 11371

[10,] 3282 8443 11483
> small.G[,1]

[1]1 481 453 3185 3350 3242 3412 3447 3557 2879 3282
> sort(small.G[,1]
+)

[1] 453 481 2879 3185 3242 3282 3350 3412 3447 3557
> order(small.G[,1])
[1] 2 1 9 3 510 4 6 7 8

# the smallest value occurs as position 2 of the original vector
# the second smallest is in position 1

# the largest is in position 6, etc.

index<-order (small.G[,1])

small.G[index,1]
[1] 453 481 2879 3185 3242 3282 3350 3412 3447 3557
> # produces the same result as sort()

vV V. V Vv V

> # can also order the rows of the whole matrix
> small.G[index,]
[,11 [,21 [,3]
[1,] 453 1356 1803
[2,] 481 1423 1740
[3,] 2879 7820 11371
[4,] 3185 10965 11051
[5,] 3242 9405 12053
[6,] 3282 8443 11483
[7,] 3350 10376 11638
[8,]1 3412 11454 12225
[9,] 3447 11580 12943
[10,] 3557 11939 12812
> # and choose the three with the smallest values of column 1.
> small.G[index[1:3],]
[,11 [,2]1 [,3]
[1,] 453 1356 1803
[2,] 481 1423 1740
[3,] 2879 7820 11371
>

[15]



